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TVP9900EVM User’'s Guide

1 Functional Description

The TVP9900EVM evaluation module is a printed circuit board (PCB) designed for evaluation of the
TVP9900 VSB/QAM receiver. The board is designed with a 36-pin connector that allows connection to
multiple radio-frequency (RF) tuner boards; the EVM is shipped with a standard tuner module. The board
is designed to provide ease of use, while allowing full evaluation of the TVP9900 VSB/QAM receiver.

1.1 Description Overview

The TVP9900EVM provides the user one RF input through a standard RF connector. The EVM provides,
as an output, a digital parallel or serial MPEG-2 transport stream that is compliant to DVB-SPI. This output
stream can be easily connected to a BER tester or to an MPEG-2 decoder, such as the TVP9000.

The differential intermediate frequency (IF) output signals from the tuner board are input to the TVP9900,
which supports processing of ATSC 8-VSB or ITU-T Annex B QAM IF inputs with forward error correction
(FEC). It provides peripheral support including automatic gain control (AGC) control, direct tuner control,
and antenna control. In general, the receiver demodulates the input IF signal into a digital MPEG-2
transport stream, with advanced integrated features for AGC control, filtering, tracking, and error
correction. An AGC control interface can be used to control the IF AGC amplifier gain in the tuner. The
outputs supported by the EVM include parallel/serial MPEG-2 outputs with error packet indicator.

A 25-MHz clock is required to drive the PLL of the TVP9900. Some tuner devices have a 4-MHz clock
output that can be used as the demodulator clock source. The TVP9900EVM has the option of using a
4-MHz clock input from the tuner as the clock source, or the default setting of using the onboard 25-MHz
crystal. This selection is controlled by Jumper 1 together with R24, R25, and R26. See for
more details.

The TVP9900 includes the option of attaching a 12-V power supply and using the modular jack interface
to provide CEA-909 compliant smart antenna control. The TVP9900 receives the antenna parameters
from the host processor via I>C and sends the modulated PWM signal to the antenna. The antenna
parameters include antenna direction, antenna polarization, preamplifier gain, and channel number.

The TVP9900EVM uses the PC parallel port to emulate the I°C bus, which provides communication with
the TVP9900 receiver and the RF tuner. WinVCC (Windows® Video Control Center), a Windows
compatible application, communicates with the devices via the 1°C and is provided on the EVM CD-ROM.
This application software provides the user interface to experiment with the programmable features and to
perform register-level and high-level control of the TVP9900 receiver and the RF tuner. The TVP9900EVM
provides the option of whether the TVP9900 or the PC is the tuner 1°C master. This is controlled with
umpers 4 and 5, and the configuration is automatically detected by the WinVCC software. See

Bection 2.7 for more details.

All trademarks are the property of their respective owners.
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2 Board-Level Description

The TVP9900EVM consists of the TVP9900EVM module and the tuner EVM module. A two-row 36-pin
connector connects the boards. The block diagram of the EVM set is shown in Eigure1l.

. —_ £ []
5VDC I Sync LED  Lock LED > | +5v
LED
251152 GPIO LED
o 8 Testpoints
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o ) =
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I’C Parallel Port
Figure 1. TVP9900EVM Block Diagram

2.1 Test Points and Jumpers

The TVP9900EVM was designed with test points and jumpers to help in evaluation and troubleshooting.
Each jumper is set by default to its preferred state for the TVP9900EVM. There are test points for 1°C SCL
and SDA, GND, 5V, 3.3V, and 1.5 V. The digital MPEG-2 transport stream data and GPIO signals are
brought out to two dual-row headers that allow easy connect to test equipment.

The 1°C address selection is made with one shunt jumper, which is only read after a reset or at power up.
The default address is OxB8.

Note: If the I>’C address is changed on either the TVP9900 board or the tuner board while the
TVP9900EVM is powered up, that device does not recognize the new I1°C address. The
reset button on the TVP9900EVM must be pressed, and WinVCC must be exited,
restarted, and configured for the new 1°C address.

Table 1. I°C Address Selection Jumper (I2CA0, JP2)

Jp2 I°C Address
ON 0xB8
OFF OXBA

Table 2. Power-Down Mode Selection Jumper
(PWRDOWN, JP3)

JP3 Mode
ON Normal operation
OFF Power-down mode
SLEUO81A—-March 2007 —Revised July 2007 TVP9900EVM User’'s Guide 7
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2.2

2.3

JP1, together with R24, R25, and R26, control whether a 4-MHz clock from the tuner or a 25-MHz clock
from the onboard crystal are used to drive the TVP9900. The jumper settings and resistor populate (POP)
or do-not-populate (DNP) options are listed in [Table 3. The default setting is for the 25-MHz clock.

Table 3. Clock Input Selection Jumper (CLKIN_SEL, JP1)

JP1 R24 R25 R26 Clock
ON POP POP DNP 25 MHz
OFF DNP DNP POP 4 MHz

The TVP9900EVM provides the option of whether the TVP9900 or the PC is the tuner I1°C master, and this
is selected with JP4 (SCL) and JP5 (SDA). The default setting is for the TVP9900 to be the I2C master.

Table 4. Tuner I°C Master Selection Jumper
(TUNSCL, JP4 and TUNSDA, JP5)

JP4 JP5 12C Master
1-2 1-2 PC
2-3 2-3 TVP9900

The TVP9900 has a CEA-909 compliant smart antenna control interface and the TVP9900EVM has the
option of supporting either a Mode A (basic one-direction control) or Mode B (advanced bidirectional
control) antenna using the 1-pin mode of the smart antenna control interface pin on the TVP9900 (pin 29).
JP6 is used to enable or disable Mode B for smart antenna support. The default setting is for Mode A.

Table 5. Mode B Selection Jumper (Mode B, JP6)

JP6 Mode
1-2 Mode A
2-3 Mode B

Common Board Interface

The TVP9900EVM uses a two-row 36-pin connector (H1) to share common signals and the 5-V power
supply between the boards. This connection allows multiple tuner boards to be connected to the
TVP9900EVM. The EVM package is shipped with a standard tuner module. This connector shares the
differential IF signals, AGC, 5 V, ground, I2C bus (SCL and SDA), and, if desired, a 4-MHz clock, two
general-purpose input/output (GPIO) signals, and reset.

Input Description

The differential IF output signals from the tuner board are input to the TVP9900, which supports
processing of ATSC 8-VSB or ITU-T Annex B QAM IF inputs with forward error correction (FEC).

The TVP9900EVM receiver has an analog input channel that accepts one differential or single-ended
44-MHz center frequency IF input that is ac coupled. The receiver supports a maximum differential input
voltage range of 1 V peak-to-peak. The programmable gain amplifier (PGA) and the AGC circuit work
together and make sure that the input signal is amplified sufficiently to ensure the proper input range for
the ADC. An external downconverter is not required to use the IF direct sampling method. The analog
front end and adjacent digital filter relax the requirement for external analog filters, and only one external
SAW filter is required.

TVP9900EVM User’s Guide SLEU081A—March 2007 -Revised July 2007
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Output Description

The EVM provides, as an output, a digital parallel or serial MPEG-2 transport stream that is compliant to
DVB-SPI. The 8-bit MPEG-2 transport stream data output of the TVP9900, together with the clock and
packet signals (see following list), are routed to a 20-pin header (H3) and then to an LVDS line driver,
which is connected to a standard DB25F edge connector. This output stream can be easily connected to a
bit error rate (BER) tester or to a MPEG-2 decoder. In serial mode, the DATAOUT7_SO pin is used as the
serial data output (available on pin 17 of header 3), with the most-significant bit (MSB) output first. The
maximum output rate is 42.1 Mbit/s in serial mode.

MPEG-2 clock and packet signals:

» DCLK - Data clock output

» PACK_SYNC - Byte start signal (indicates the first byte of a transport stream data packet)
 BYTE_VALID - Interface packet framing signal (indicates length of the valid data packet)
 D_ERROR - Interface data error (indicates an error in the data output packet)

3 System-Level Description

A system-level block diagram incorporating the TVP9900 is shown in Figure 2. The primary features of

this configuration are:

» Power is provided by a single 5-V power supply provided with the EVM and is shared between both

modules via the 36-pin connector.

e Supports one RF input through a standard RF connector

» Provides 8-bit MPEG-2 parallel or serial transport stream data output

« I2C bus initializes the video devices via a PC parallel port.

» TVP9900 VSB/QAM receiver performance parameters may be measured with a BER tester.

Power
Computer Supply
A
MPEG-2 MPEG-2
RF RF IF.| TVP9900 Transport Stream Decoder or
pTv Tuner Module BER Tester
Source Module
TVP9900EVM
Figure 2. TVP9900EVM System-Level Block Diagram

4 Required Hardware and Equipment

The required hardware and equipment necessary to use the TVP9900EVM are:

» TVP9900EVM (provided)

» Universal 5-V power supply (provided)

» Parallel cable (provided)

e Windows-based PC with CD-ROM drive and Win95™ or later

* RF cable for input

» Parallel cable for output

* RF video source (terrestrial antenna, DTV cable, 8VSB/QAM test transmitter, etc.)

» MPEG-2 decoder or BER tester
SLEUO81A—-March 2007 —Revised July 2007 TVP9900EVM User’'s Guide 9
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Hardware Setup

shows the TVP9900EVM layout and indicates the location of the power supply and the
appropriate connectors. All connectors are labeled according to their function. To prepare the EVM for
evaluation, connect the following:

1. There are two parallel interfaces on the EVM. The one labeled J3 is for the IC interface to the PC.
Connect a parallel port cable from this connector on the EVM to the PC.

2. The other connector, labeled J2, provides a digital MPEG-2 transport stream that is compliant to
DVB-SPI. Connect this to a BER tester or to an MPEG-2 decoder.

3. Connect an RF video source to the TVP9900EVM tuner board RF input.

4. Connect the 5-V power supply to the dc jack on the TVP9900 board. A green LED on the board should
now be lit.

The I2C slave address can be selected with jumper JP2. There are two possible addresses: 0xB8 and
OxBA. The default setting for this jumper is for the shunt to be in place, which selects 0xB8. This is
connected to TVP9900 pin 38, which is read at power up. If the shunt is removed and the EVM reset, the
TVP9900 now responds to I2C slave address OxBA. The tuner I2C address is set by default on the tuner
EVM board to 0xC2 (tuner board jumper JP1 is open). This jumper setting is required to match the 1°C
slave address in the Tuner Type window in the WinVCC software.

Note: If the I°C address is changed on the TVP9900 or tuner board while the TVP9900EVM is
powered up, the device does not recognize the new I°C address. The reset button on the
TVP9900EVM must be pressed, and WinVCC must be exited, restarted, and configured
for the new 1°C address.

Software Installation

WinVCC is a Windows application that uses the PC parallel port to emulate I°C, providing access to each
device on the I°C bus. WinVCC makes use of CMD files, which are text editable files that allows preset
receiver setups to be programmed easily.

This feature allows the user to easily set multiple I°C registers with the press of a button. WinVCC also
has property sheets for the TVP9900, which allow the user to control the I°C registers with a GUI. A tuner
control page is provided to setup and control the included RF tuner.

All necessary software for the TVP9900EVM is provided on the enclosed CD. Perform the following steps
to install WinVCC:
1. Explore the provided TVP9900EVM software CD.

2. Install Port95NT.exe. This is the parallel port driver used by WinVCC. This driver must be installed and
the PC must be rebooted before WinVCC can operate correctly. This does not affect normal parallel
port operation.

3. Install Setup.exe. Click Next at all prompts and click Finish to complete the installation process. This
installs WinVCC onto the PC. No reboot is required.

4. Run WinVCC.exe.

Note: A shortcut to WinVCC and additional TVP9900 related documentation can be found at
Start - All Programs - TVP9900EVM Software.

10
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7 WinVCC Quick Start

Perform the following steps to get an MPEG-2 transport stream out of the TVP9900EVM.

1. Once WinVCC is executed, the WinVCC Configuration screen appears, as shown in . This
dialog box configures the I1°C bus. Next to TVP9900, select the TVP9900 and ensure the I°C address
is set to OxB8 (default setting on EVM.) This must match the 1°C ADDR jumper on the TVP9900 board.

2. The tuner I°C address is set by default in WinVCC to 0xC2. This is also the default setting on the tuner
EVM board; verify the correct TUNER_AS jumper setting on the tuner board.

Note: If WinVCC is running and the TVP9900 or tuner board 1°C address is changed, power
must be cycled on the EVM.

Win¥CC Configuration

12C SY3TEM COMFIGURATION

DEYICE FAMILY SPECIFIC DEVICE 12C BUS MASTER |20 SLAVE ADDR
TVPI000 [NOT USED =l
[HDTW Wideo Proceszor] |20 Slave Addr
TPI300 & Beh O B&h
[ATSCAUAM Demaodulatar) | J
VID_DEC [ DVB  |NOT USED = | | | @ BBh © Bah
[Analog Wideo Decoder)
WID_ENC MOT USED hd (+ A0h  42h
[&nalog Wideo Encoder) | J | J
™P7000 T DVE [noT useED - " BBh * Bah
[Wideo/Graphizs Digitizer) | J | J
THS8200
HDTv/SDTv/RGE Dag) | NOT USED =] | = | € an @4

PROGRAM OPTIONS
EMABLE | [2C Spstem Test [after clicking OK]

EMABLE | 2C Acknowledge Checking

Hele

ENABELE Auta-Update fram Device [when activating a
windaw ar tabhing bebwesn property pages)

QK | Exit Program

Figure 3. WinVCC — I°C Configuration Screen

3. Ensure that all other boxes are set to NOT USED and that all program options buttons are set to
ENABLE. Click OK.

4. If there are no 1°C communication issues, the WinVCC Main Screen dialog window displays next, as
shown in Figure 4. If there are 1°C issues, an I°C Test Report box displays. Completely exit out of
WinVCC, double check the parallel port cable connections, cycle power on the TVP9900EVM, and run
WinVCC again.

A2 Windows ¥ideo Control Center E”E|E|
File Edit Tools ‘Window Help

Figure 4. WinVCC — Main Screen
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5. Load the provided initialization command (CMD) file into WinVCC by clicking on Tools — System
Initialization and clicking Browse. The default directory is C:\Program Files\Texas
Instruments\WinVCC\TVP9900\Initialization.

6. In the System Initialization Window, shown in Figure 5, click the "Program TVP9900 - 8-VSB mode -
outputs enabled" dataset in the window and then click PROGRAM Device(s) Using Selected Dataset to
initialize the TVP9900EVM for 8-VSB mode. The 64QAM mode and 256QAM mode can be set up by
using the other datasets in this command file.

System Initialization

Command File |C:\Program FileshTexas Instrumentsiafint CCLTYPII0 04 nitialization' nitialization. crd Browse. .
Command File Operations Biytes Per Black oo
= Al eloa
REFLACE APPEND PROGRAR (0= Allin 1 block]
Selected Datazet Current Device(s] 0 §
with Current Device Settings Lsing Werify...
Device Settings ta CMD File Selected Datazet Status

| Reads Close

D atazet Descriptions

n T o mods - outputs enabled
2 = Program TWP3300 - 6404M mode - outputs enabled
3 = Program TWP3300 - 256040 mode - outputs enabled

M) LoD~ M
T L L (R

[ —Y

NOTES:
1. To access the factorp-supplied initialization files, browse to: c:\Program FileshT exas InstrumentswinyCC4TYPI00N nitialization*. crnd

2 IFREPLACE or APPEND functions will be used. click RELOAD whenever the video decoder EVM iz reset or power-cycled.

Figure 5. WinVCC — System Initialization

7. Click Close.

8. Program the tuner by clicking Tools — TV Tuner Control - ATSC. The Tuner Type window, as shown in
Figure 6, allows the user to select tuner and source settings. Select the Standard Digital ATSC Tuner
button and click on OK to use the default tuner shipped with the TVP9900EVM.

ATSC Tuner, Type

Select ATSC Tuner RF Source
‘ Standard Digital ATSC Tuner & Dver the Air
" Cable

Cable Center Frequency T able

f« STD /IRC
Cugtorn Digital TSC Tuner " HRC[=5TD -1.25 MHz ]

Tuner [2C Slave Address IE [Hex] a4 | Cancel ‘

Figure 6. ATSC Tuner Type

9. In the TV Tuner Control window, as shown in Eigure 7, select a channel from the "Add to Channel List"

12
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drop down box.
10. Click Add. After approximately one second, the tuner is programmed to the selected channel.

11. For direct entry of the RF center frequency, type in the center frequency (for example, 189) into the
"RF Center Freq (MHz)" box. Click Program to program the tuner.

TV Tuner Control: ATSC @

Selected Tuner Type Tuner [2C Maszter
| Digital 4T SC Tuner, OTA, 0xC2 I L
f+ Fast [400KHz]
Channel Scan Tunable Channel List
Start
Channel Changer ChUp ‘
Q | =] E
Ch Down
Addto Ch List kadulation
o Channel Lis
YSB-B
Channel Mumber
- 2
Femove Channel ‘ Remove Al ‘
Add
Chanrel Status Center Freq. Entry

Sync Lock Requirements A Contor Free (K4
v Field Sync enter Freq [MHz

Channel Active ’7
v Timing Recovery @ 189.00
O Tuner Locked

v FEC Spnc
Pre-Delay @ Power-On Reset
1000
[0 - 5000 ms] O Tuner AGC Ok
Apply | 0Kk | Readal

Figure 7. TV Tuner Control for ATSC

12. To perform a channel scan when the input is from an antenna (or cable), click Start on the TV Tuner
Control page. This selects all channels for which the TVP9900 indicates locked status. The locking
criteria are selectable on this page: Field Sync Lock (Default: ON), Timing Recovery (Default: ON), and
FEC Sync Lock (Default: ON). The Pre-Delay is not needed.

13. After scanning, switching between channels can be easily done using the channel up/down buttons
(Ch Up and Ch Down) or the "Channel Changer" drop-down list.

14. Click OK to close the TV Tuner Control tool.
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15. Open the TVP9900 Property Sheets by clicking Edit - Property Sheets - TVP9900. Click on the Status
tab, as shown in Figure 8. Click Auto-Update to enable it, and then click Soft Reset. The demodulator

and FEC status are shown on this page.

T¥P 900 (0xB8) Property Sheets

Mode Select | MPEG Ouput  Status |
Demodulatar Farward Errar Correction (FEC)
AGLC Accumulator
156740
-B12K 0 512K
Symbol Rate [MHz)
10.761810
10760 10762 10.764 Auto-Update Delay @ FEC Sync Lack
0 ms
Slow Fast
DFT Freq Offset [KHz) g ]
26.345794 RED = Naot Locked
YEL =Hunting
280 ] 280 Status Capture GRM = Locked
Update Interval
DCL Average Ermor [dE] [R5 Blocks]
] 29325 25768 [Dec) Soft | DevicelD[ 9300 Fimware Ver. [v2.00.00
-30 1] e Reset
Errar Status
Segment Enors # Sec Erar Rate Errars
0 0
1.0 50 10.0
4-Channel Scope ‘
Conztellation / Eve Diagram ‘
INTREQ Polarity  Auto-Update
ACTIVE LOW | ENABLED |
0K | Cancel | Apply |

Figure 8. TVP9900 Property Sheets

16. With an RF source provided to the tuner RF connector, and the EVM output connected to a BER
tester or MPEG-2 decoder, the MPEG-2 transport stream should be available. If the transport stream is

not output from the TVP9900EVM, ensure the following is correct:

e The input/output cables are connected correctly to the sources, EVM, and tester/decoder.
e The input source is working properly and providing the expected RF input. Lock can be confirmed

with the above property sheet.

* The correct dataset is selected and programmed for the correct RF input format.
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8 WinVCC in Depth

The following sections describe how to use WinVCC in depth. It discusses various features and screens
that the user may encounter while evaluating the TVP9900EVM.

8.1 Starting WinVCC

The Port95NT parallel port driver must be installed before using WinVCC. WinVCC may be started by
clicking on Start - All Programs - TVP9900EVM Software - WinVCC.

If the dialog box shown in is displayed, then it means one of two things:

*  WinVCC terminated abnormally the last time it ran. In this case, click OK to exit the program and
restart WinVCC.

» There is more than one instance of WinVCC running at the same time. In this case, click OK to exit the
program. Then, press Ctrl+Alt+Delete to open the Task Manager. Select and click End Task on all
occurrences of WinVCC or WinVCC CONFIGURATION. Restart WinVCC.

If the previous run of WinWCC was terminated abnormally, click OK and start WinWiCC again. Otherwise, more than one instance of WinWCC may be running! Click Ok
! to close this program, Then, press CERAl-Delete, Highlight and click "End Task" to terminate all instances of Windows Yideo Control Center (or WINYCC

Configuration).

Figure 9. WinVCC Multiple Occurrences Error Message

8.2 WinVCC Configuration Dialog Box

The WinVCC Configuration dialog box, as seen in Figure 10, should now be visible. This dialog box
configures the 1°C bus on the TVP9900EVM. All settings from this dialog box are stored in the Windows
registry and are restored the next time the program is started. After initial installation, the TVP9900
(QAM/VSB Receiver) device family is set to TVP9900, and all other devices are set to NOT USED.

The 1°C slave address for each device must match the 1°C slave address selected by jumpers on the
TVP9900EVM. These jumpers are set by the factory to use 0xB8 for the TVP9900 and 0xC2 for the tuner.

All Program Options must be enabled. Disabling these options is only required if you are debugging a
problem with the I°C bus.

Click OK to begin I?°C communication with the selected devices.
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8.3

Win¥CC Configuration

I2C SYSTEM CONFIGURATION

FROGRAM OPTIONS
EMABLE | [2C Spgtem Test [after clicking OK)

EMABLE | [2C Acknowledge Checking

Ele

o]

ENAELE Auto-Update from Device [when activating a
window or tabhing bebween property pages]

E it Prograrn

DEVICE FAMILY SPECIFIC DEWICE I2CBUS MASTER
TwP3000 |NDT USED ﬂ
[HDTW ideo Processor]
TWP3300 | J
[ATSCADAM Demaodulatar)
yiD_DEC [ DWE |NUT USED j | J
[Analog Videa Decoder)
WID_EMC MOT USED -
[#nalog Wideo Encoder) | J | J
™R7000 | DVE Mot UsED -
[Wideo/Graphics Digitizer) | J | J
THS8200
HDTV/SDTv/RGE DAy |NOT USED =] | [

[2C SLAVE ADDR

12C Slave Addr

f* Bth

+ BBh

* 40k

" BBh

" 40h

" Bah

" Bah

Figure 10. WinVCC I°C Address Configuration

|2C System Test

The I2C system test of the selected devices runs immediately after closing the WinVCC Configuration
dialog box by clicking OK (unless the I°C system test program options button was disabled).

If the test fails, a dialog box similar to appears. See [Bection 10, Troubleshooting, for details on

how to resolve this issue.

The 1°C system test can be run at anytime by clicking Run System I1°C Test in the Tools menu.

16
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I2C Test Report

TWP3300. FAILED - Read. Dew=0«B8, Addr=0x57, Data=0x05 - Mizcompare MWrote 0=01]

Figure 11. I>’C System Failure

8.4 Main Menu
After closing the WinVCC configuration dialog, the main menu is displayed (see Figure 17). The menus
that are used to operate WinVCC are File, Edit, Tools, Window, and Help. The File menu’s only function is
Exit, which terminates the program. summarizes the main menu contents.

A2 Windows ¥ideo Control Center |’._||’E|rz|
File Edit Tools ‘Wwindow Help

Figure 12. WinVCC — Main Screen
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Table 6. Main Menu Summary

Menu Contents

File Exit

Register Map
TVP9900
Edit Generic I1°C
Property Sheets
TVP9900

System Initialization
Real-time Polling
TV Tuner Control

NTSC CATV

PAL CATV

ATSC
Multi-byte 1°C Transfers
Set I>C Bit Rate
Run System 1°C Test
Run Continuous I°C Test

Window Allows selection of the active window. Multiple windows can be open at the same time.

Tools

Help Displays program version

8.4.1 System Initialization
Clicking System Initialization in the Tools menu displays the dialog box shown in Figure 13. This dialog
box provides the means for initializing the TVP9900 receiver for a particular IF input mode. The details of
the initialization are contained in the command file (with a CMD file extension).
The command file is loaded by clicking Browse. Once the command file is opened, a text list displays
descriptions of the individual datasets contained within the command file.
Click once on the desired dataset description to select it. Click Program Device(s) Using Selected Dataset
to run the selected dataset, which loads the devices via the I1°C bus. When the device initialization has
completed, the status indicator displays Ready.

Note: If Ready does not display, the devices are not initialized, and the 1°C bus is not
communicating. See Becfion 10, Troubleshooting, for possible solutions.

Click Close to close the dialog box. Each time the System Initialization dialog box is closed, the
initialization file pathname and the dataset selection number are saved in the Windows registry to allow
these settings to be retained for the next time WinVCC runs.
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System Initialization

[ Ready Close

Command File |C:\Program FileshT exaz Instrumentz\winy CCATWP33 00 nitialization nitialization. crd Browsze...
Command File Dperations Bytes Per Block oo
Al eloa
REFLACE APPEND PROGRAM (0= Allin 1 Block]
Selected Datazet Current Device(z] 0 §
with Current Device Settings Using Werify...
Device Settings ta CHMD File Selected D ataset Stabus

Datazet Descriptions

1 = Program T%P3300 - 8-%5B mode - outputs enabled
2 = Program TWP3300 - B404AM mode - outputs enabled
3 =Program TWP3300 - 2560AM mode - outputs enabled

4=
5=
E=
7=
g=
9=
0=
1=
=
3=
4=
E=

Y

MOTES:
1. To access the factory-zupplied initislization files, browse to: c:%Program Files\Texas InstrumentsyWinCCAATWPII004 nitializationy™. cmd

2. [F REPLACE or APPEND functions will be used, click RELOAD whenever the video decoder EVM is reset or power-cycled.

Figure 13. System Initialization

8.4.1.1 Adding a Custom Dataset

After programming the EVM via the System Initialization tool using the factory-supplied command file,
customize the device register settings to fit the application needs. Perform the following steps to save the

custom settings:
1. Reopen the System Initialization dialog box via the Tools menu.

2. Click Append Current Device Settings to Command File. A dialog box requesting a description of the

new dataset appears.
3. Optionally, click the drop-down box and select one of the existing descriptions.

4. Modify the description text or type your own description.

5. Click OK. All non-default register values from the TVP9900 and tuner are appended to the current

command file as an additional dataset.

Select the custom dataset and load it by clicking Program Device(s) Using Selected Dataset.

Using the same procedure but clicking Replace Selected Dataset with Current Device Settings overwrites
an existing dataset with the current settings.

Note:

text.

If editing the command file (.CMD) using a standard editor, the file must be saved as plain

8.4.1.2 Command Files
The command file is a text file that can be generated using any common editor; however, it must be saved

as plain text. In Windows Explorer, use right-click — Edit to open a command file. (Double clicking on a
command file or using right-click -~ Open causes the command file to run as a script in a DOS window.)

Command files are especially useful for quickly switching between various system configurations. A
default command file has been provided on the CD. This command file contains examples of common

setups. This command file is located at:
C:\Program Files\Texas Instruments\WinVCC\TVP9900\Initialization\
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A command file can contain up to 250 datasets. A dataset is a set of register settings to initialize the
TVP9900 receiver and/or tuner for a particular IF input mode. Each dataset includes a description that is
displayed in one row of the dataset descriptions list. The register settings may be located in the command
file itself and/or may be stored in separate include file(s) (with an .INC file extension) and be included into
the command file using the INCLUDE statement.

8.4.1.3 Example Command File

An example of one dataset within a command file is shown below.
BEG N_DATASET

DATASET_NAME, " Program TVP9900 - 8-VSB npde - outputs enabl ed"

WR_REG TVP9900, 1, 0X53, OXFF // Enable outputs and cl ock
WR_REG, TVP9900, 1, 0X54, 0X03
WR_REG TVP9900, 1, 0X00, 0X20 // soft reset

END_DATASET

Each command file may contain individual write-to-register (WR_REG) commands.
* The comment indicator is the double-slash, //.

» The command file is not case sensitive and ignores all white-space characters.
» All numbers can be entered as hexadecimal (beginning with 0x) or as decimal.

» Every dataset in a command file begins with BEGIN_DATASET and ends with END_DATASET. The
maximum number of datasets is 250.

e The dataset text description is entered between double quotes using the DATASET NAME command.
The enclosed text can be up to 128 characters in length. This text appears in the System Initialization
dialog box when the command file is opened.

* The INCLUDE command inserts the contents of an include file (with an .INC file extension) in-line in

place of the INCLUDE command. Therefore, the include file must not contain the BEGIN_DATASET,
END_DATASET, and DATASET_NAME commands.

Note: Allincluded files must be located in the same directory as the command (CMD) file.

» The write-to-register command is written as follows:
WR_REG, <DeviceFamily>, <Number of data bytes (N)>, <subaddress>, <Datal>,..., <DataN>
or
WR_REG, <Literal slave address>, <Number of data bytes (N)>, <subaddress>, <Datal>,..., <DataN>
The valid device family mnemonics are:
VID_DEC for the video decoders
VID_ENC for the video encoders
TVP9000 for the TVP900x HDTV video processors
TVP9900 for the TVP9900 VSB/QAM demodulator
TVP7000 for the TVP700x video/graphic ADC devices
THS8200 for the THS8200 HDTV/SDTV/RGB DAC device
WinVCC translates the device family mnemonic to the slave address that was selected in the WinVCC
Configuration dialog box upon program startup. This eliminates the need to edit command files if the
alternate slave address must be used.
If the literal slave address method is used, then the slave address entered is used directly. This
method can be used for programming the tuner.
* A delay may be inserted between commands using the WAIT command, which is written as follows:
WAIT,<# milliseconds>

« If an I°C write without a subaddress is required, use two consecutive commas instead of
"subaddress,".
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8.4.2

Register Editing

The following sections describe the three available modes of register editing: register map editor, generic
I2C register editor, and TVP9900 property sheets. Each of these functions can be selected from the Edit

menu.

8.4.2.1

Register Map Editor

The register map editor (see allows the display and editing of the entire used register space of
the device within a simple scrolling text box. To open this, click on Register Map in the Edit menu and
click on the device type to edit. describes how to use each of the controls in the register map

TYP 3300 (0xB8) Register Map

editor.

Addless| [ata | R | MName | Description | ~
] aa R Receiver Contral 1/50ft Reset
o 11 R Receiver Contral 2
03 uli] RAs WSE Control 1
04 o1 RAw AGC Contral 1
1B BC RAW WSB FEC Time Counter Contral 1
1C E4 R WSB FEC Time Counter Control 2
1D aa R WSB FEC Time Counter Control 3
1E aa RA% QM FEC Time Counter Control 1
1F 03 R Qak FEC Time Counter Contral 2 5
MOTE 1: Any address not shown in the list can be accessed by tping the address and then clicking Read or Wiite.
Loop Count Loop Count R adi
Address Wiite [ 1 Aeplestowite A
oo =l Fiead and Read Al Dec
=1 [1-939) Hex (&
Bt Read Higtogram on Loop Count Feads [or Read Alls)
ata
AND [TFp Show
oo i
= Read Al Mask  Olose |
Figure 14. Register Map Editor
Table 7. Register Map Editor Controls
Control Definition

Register Window

Scrolling text box that displays the address and data for the I°C registers that are defined for the device

Address Edit Box

This contains the I°C subaddress that is accessed using the Write and Read buttons. Clicking on a row
selects an address, which then appears in the address edit box.

NOTE: After clicking on a row, the Data Edit box contains the data that was in the register window. The
device has not yet been read.

The address up/down arrows are used to jump to the next/previous subaddress that is defined for the
device. If an address is not defined for the device, it can still be accessed by typing the subaddress in
the Address Edit box.

Data Edit Box

This contains the data which will be written to or was read from the I1°C subaddress. The data up/down
arrows increment/decrement the data value by 1.

Write Button

Writes the byte in the Data edit box to the address in the Address edit box. The I2C register is written to
whether or not the data is different from the last time the register was read.

Read Button

Reads the data from the address in the Address edit box into the Data edit box and the register window

Read All Button

Reads all defined readable registers from the device and updates the register window

Hex Button

Converts all values in the register window and address and data edit boxes to hexadecimal

Dec Button

Converts all values in the register window and address and data edit boxes to decimal

Close Button

Closes the dialog
NOTE: Multiple edit register map windows can be open at the same time (one for each device). Use the
Window menu to navigate.

Loop Count

Causes subsequent write, read, or read all operations to be performed N times. N is entered as a
decimal number from 1 to 999.
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8.4.2.2

Generic 12C Register Editor

The generic 1°C register editor (see allows the display and editing of any device on the I1°C bus.
This editor works like the TVP9900 register map editor, except that the 1°C slave address must be entered
and the Read All button is disabled.

To open this window, click Register Map in the Edit menu and then click Generic 1°C.

Generic [2C Register Map

Addressl D ata | R | MHame | Diescription | »~
an - RAn
o Raw
0z R
03 RAn
04 RAn
05 R
06 RAn
o7 Fian
[ul:] RAn b

12C Slave
Address

[ Use Repeated Start

Loop Count Loop Count A adi
Address White 1 Applies o 'wiite, ac
ﬂ Read and Read All Dec

i1-939) Hex &

.. Read Histogram on Loop Count Reads [or Read Alls)
ata
AMD
| [ Enable FF Shaw
|’ : M ask Close

Figure 15. Generic 1°C Register Editor

8.4.2.3 TVP9900 Property Sheets

The property sheets represent the register data in a user-friendly format. The data is organized by
function, with each function having its own page and being selectable via tabs at the top (see Figure 18).

To open this, click on Property Sheets in the Edit menu and select the device type to edit.

When the property sheet function is started or when tabbing to a different page, all readable registers in
the device are read from hardware to initialize the dialog pages. Values on the page are changed by
manipulating the various dialog controls as described in the [Table .

There are OK, Cancel, and Apply buttons at the bottom of each property page. These are explained in
lable 9.
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T¥P9900 (0xB8) Property Sheets

Mode Select | MPEG Duiput  Status |
Demadulatar Fonward Error Carrection (FEC)
AGC Accumulator
156740
512K 0 512K
Symbol Rate [MHz)
10.761810
10760 10762 10.764 futo-Update Delay @ FEL Sync Lack
o ms
Slow Fast
DPT Freq Offset (KHz) [ ]
26345794 RED = Mot Locked
YEL =Hunting
250 ] 280 Status Capture GRM = Locked
Update Interval
DCL Average Erar [dB] RS Blocks]
] 29.325 25788 D) Soft | DevieeID| 9900 Firnware Ver. [+2.00.00
-30 0 30 Reset
Error Statuz
Segment Enois / Sec Emor Rate Ermars
0 0
1.0 50 10.0
4-Channel Scope ‘
Constellation / Eve Diagram ‘
INTREQ Polarity  Auto-Update
ACTIVE LOW EMABLED |
0K | Cancel | Apply |

Figure 16. Property Sheets

Available on the TVP9900 Property Sheets Status page is a Constellation / Eye Diagram plot tool and a

four-channel virtual oscilloscope tool. Both analysis tools are accessed by clicking on the respective button
on the Status page.

The Eye Diagram / Constellation window (see displays signal variation at the carrier recovery
slicer input with persistent plots and allows the user to save data to a log file. The eye diagram displays

I-data at three consecutive points, and the constellation plot shows the distinct I-data levels along the
horizontal axis.

TVP9900 Eye Diagram / Constellation: DCL Output{l,Q)

Eye Diagram Select Signal | DCL Output(l.G] Canstellation Plat

-64 -32 1] 32 64

Draw Plot  Saveto LogFile  Bytes Saved Draw Plot  Saveto LogFile  Bytes Saved B
Enabled Disabled | 0 Enabled Disabled | i I
No Grid [
Resel

Figure 17. Eye Diagram / Constellation Plots
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The four-channel oscilloscope tool (see stores all acquired data from time zero and provides

the option of saving data for off-line analysis. This tool provides many useful features to aid in signal
analysis, including the following:

» Real-time plots of up to four status registers

* Real, magnitude, phase, or Doppler plot types

» Variable time and division

» Variable Y offset and Y scale, with automatic Y scale
e Horizontal pan and zoom

Four Channel Scope

AGC dccumulatar, Real

Selected Channel Controls 47500
Plot Type

Chanrel

' -~ -48500
[H1 Feal i fﬂ«\f‘ Y
tH2 Change Signal -49500 g :
£H3 Hide Plot *50500
gl ' 51500
iyt 10761883
10761882
' Offzet Y Srale
40000 p 1.000 r 10761881
Down|  (Units ¢ Division) 10761880
Enter
10761879
Cursars
: -9500
Shaw Find
; -10000
T1|27.950 T2 | 29437
-10500
DeltaT | 1487 1/DetaT| 0672
-11000
Eommon. Controlz 11500
Ruri Auto Scale
Reset |
Stop Hide Grid b
25 [T
24
1000 500
Delay
...... 23
] ms
22
3 i 25 26 27 28 29 30
Tlme_ = [Se_c_:] Ll Zoom In Reference Time [seconds]
b 1 Less Orange Cursor » Close | 4 [»

Figure 18. Four Channel Scope

8.4.2.3.1 Property Sheet Refresh
The property sheets were designed so that the data displayed is always current. Certain actions cause the
entire register map to be read from the device and to update the property sheets:
* When property sheets are initially opened
* When tabbing from one page to another
*  When Read All is clicked
* When making the property sheets window the active window (by clicking on it)
* When making a register map editor window the active window (by clicking on it)

8.4.2.3.2 Auto-Update From Device

Items 4 and 5 above are referred to as the auto-update feature. Auto-update can be disabled by setting its
program option button to DISABLED. This button is located on the initial dialog box (WinVCC
Configuration).
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The user can open both the property sheets and the register map editor at the same time, and changes
made to the property sheets (and applied) are updated in the register map window as soon as the register
map window is clicked on. Additionally, changes made in the register map editor are updated in the

property sheets as soon as the property sheets window is clicked on.

Table 8. Use of Property Sheet Controls

Dialog Control

What Do | Do With It?

When Is Hardware Updated?

Read-only edit box Read status information N/A

Check box Toggle a single bit After Apply
Drop-down list Select from a text list After Apply
Edit box Type a number After Apply

Edit box with up/down arrows

Use up/down arrows or type a number

Up/Down Arrows: Immediately
Type a number: After Apply

Slider

Slide a lever

Immediately

Push button

Initiate an action

Immediately

Table 9. Property Sheet Button Controls

Button Control

Definition

OK Writes to all writeable registers whose data has changed. A register is flagged as changed if the value to

be written is different from the value last read from that address. Closes the dialog.

Cancel changed in hardware.

Does not write to hardware.
Closes the dialog.

Causes all changes made to the property page since the last Apply to be discarded. Changes made to
dialog controls with ‘immediate hardware update’ are not discarded, since they have already been

Apply

Writes to all writeable registers whose data has changed. A register is flagged as changed if the value to
be written is different from the value last read from that address.
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9

TV Tuner Control

This chapter discusses how to program the tuner on this EVM. Program the tuner by clicking Tools - TV
Tuner Control » ATSC. The Tuner Type window (see Figure 19) allows the user to change the tuner 12C
slave address (C2h by default) and RF source settings. Click the Standard Digital ATSC Tuner button and
click OK to use the default tuner shipped with the TVP9900EVM.

ATSC Tuner Type

Select ATSC Tuner RF Source

‘ Standard Digital ATSC Tuner % Over the Air
" Cahble

Cable Center Frequency T able

f« STD /IRC
Cugtom Digital ATSC Tuner " HRC[=5TD -1.25MHz)

Tuner [2C Slave Address IE [Hex] a4 | Cancel

Figure 19. ATSC Tuner Type

To use other tuner boards that have the same TVP9900 EVM board interface, click the Custom Digital
ATSC Tuner button. This allows the user to select a tuner configuration file that is used to program the TV
Tuner Control settings to work with the desired tuner. Additional details and an example Tuner
Configuration File can be provided by Texas Instruments if this option is desired.

In the TV Tuner Control window (see Figure 20), select a channel from the "Add to Channel List"
drop-down box. Click Add. After approximately 1 second, the tuner is programmed to the selected
channel. For direct entry of the RF center frequency, type in the center frequency (for example, 189) into
the "RF Center Freq (MHz)" box. Click the Program button to program the tuner.

26
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T Tuner Control: ATSC @

Selected Tuner Type

Channel Scan

Start

i

Add to Channel List
Channel Mumber

|

Add

Syne Lock Requirements
v Field Sync
v Timing Recoverny

lv FEC Sprc:
Fre-Delay

1000

[0 - 5000 ms]

Apply ‘

| Digital ATSC Tuner, 0TA, OxC2

IZIK|

Tunable Channel List

Channel Changer ChUp ‘
B
Ch Down
Modulation
Y5B-8

Remowe Channel ‘ Remaove Al ‘

Channel Statuz Center Freq. Entry

RF Center Freq [MHz)

189.00

O Channel ctive

O Tuner Locked

0 Power-0n Reset

{20 Tuner AGC On

Read Al

Tuner [2C Maszter
v Lze TWPIS00

" 5id (100KHz]
f* Fast (400KHz)

Figure 20. TV Tuner Control for ATSC

To perform a channel scan when the input is from an antenna (or cable), click Start on the TV Tuner
Control page. This selects all channels for which the TVP9900 indicates locked status. The locking criteria
are selectable on this page: Field Sync Lock (Default: ON), Timing Recovery (Default: ON), and FEC Sync
Lock (Default: ON). The Pre-Delay is not needed. After scanning, switching between channels can be
easily done using the channel up/down buttons (Ch Up and Ch Down) or the "Channel Changer"

drop-down list.

Open the TVP9900 Property Sheets by clicking Edit - Property Sheets - TVP9900. Click the Status tab, as
shown in Eigure 1d. Click Auto-Update to enable it, and then click Soft Reset.
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10  Troubleshooting
This chapter discusses ways to troubleshoot the TVP9900EVM.
10.1 Troubleshooting Guide
If you are experiencing problems with the TVP9900EVM hardware or the WinVCC software, see
for available solutions.
Table 10. TVP9900EVM Troubleshooting
Symptom Cause Solution
At startup, the error message Cannot ' A .
find DLL file DLPORTIO.DLL The parallel port driver supplied with | o\ poto5NT.EXE on the CD to install the driver.
the EVM has not been installed.
appears.
Program the tuner by clicking Tools - TV Tuner
Control - ATSC. The tuner type and settings are
Tuner is not programmed correctly. programmed for the default tuner shipped with the
EVM. Different tuners must be programmed
Blank screen separately.
Go to Edit— Property Sheets - TVP9900, MPEG
Maillieetfi dﬁ;io;?lé}z'ag:ggk’ or Output Control page, click the DATAOUT Enable
p 9 ’ and Signal Enable buttons and click Apply.
WinVCC I2C test fails unexpectedly Initial test fails to operate correctly. Exit out of WinVCC, and restart.
Make sure IC slave address jumper on the
Receiver I°C slave address is wrong. | TVP9900 receiver module is set for the correct
address.
2 . Make sure IC slave address jumper on the tuner
Tuner IC slave address is wrong. module is set for the correct address.
Parallel cable is not connected from
PC parallel port to the TVP9900 Connect cable
receiver module DB25 connector.
Power supply must be plugged into a 100-V to
. 240-V/47-Hz to 63-Hz power source, and the cord
EVM is not powered on. must be plugged into the power connector on the
EVM
o Some parallel cables are not wired straight through
No I°C communication Wrong type of parallel cable pin-for-pin. Use the cable supplied with the EVM.
Device was placed in nower-down Verify jumper JP3 is set to its default (shunt is on)
mode p p position. Press the Reset button on the TVP9900
’ Receiver Module.
DO THIS AS A LAST RESORT. Reboot PC, enter
BIOS setup program, and set parallel port LPT1
PC parallel port mode is not set mode (Addr 378h) to ECP mode or bidirectional
correctly. mode (sometimes called PS/2 mode or byte mode).
If already set to one of these two modes, switch to
the other setting (see Bection 10.4.)
PC may not be capable of operating in the required
. 2 _— parallel port mode. This is true of some laptop
Still no 1“C communication .
computers. Use a different computer, preferably a
desktop PC.
When WinVCC is started and the WinVCC Configuration dialog box is closed with OK, the 1C system test
is performed (unless the 1°C System Test program option is disabled).
If the 1°C system test fails, a dialog box like appears. This example reports that a read from
TVP9900 failed, using slave address 0xB8, subaddress 0x57. The data read was 0x05. The expected
data was 0x01.
After noting which device had a problem, click OK to continue. Next, the Corrective Action Dialog box
appears to help fix the problem.
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I2C Test Report

TWP3300. FAILED - Read. Dew=0«B8, Addr=0x57, Data=0x05 - Mizcompare MWrote 0=01]

Figure 21. I°C System Failure Dialog Box

10.2 Corrective Action Dialogs
After closing the I2C system test report dialog box, a corrective action dialog box appears (see Figure 22).

1 E Iz a parallel cable connected from the computer's LPT1 port to the evaluation module (E¥M) and power applied ko the EYM ¥
-

Yes Mo |

Figure 22. Corrective Action Dialog Box

1. If the parallel port cable is NOT connected between to PC and the TVP9900EVM or if the EVM power
is not on:
a. Click No.
b. The dialog box shown in appears instructing you to correct the problem.
c. Correct the problem.
d. Click OK to continue. The main menu dialog should appear.

! 'f Connect a parallel cable From the computer's LPT1 pork ta the EVM and apply power to the EVM, Then, click Ok,

Figure 23. Corrective Action Required
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2. If the cable is connected from the PC parallel port to the TVP9900EVM and the EVM power is on:

a. Click Yes.

b. The dialog box shown in appears. This dialog box appears if the PC parallel port mode
setting may need to be changed.

Note: Only run the PC BIOS setup program if the I>°C communication problem cannot be
resolved in another way (correct slave address settings, reset, or power cycle the
EVM and/or check that the device type selected was TVP9900).

Click OK to continue.

The main menu dialog appears.

Click Exit in the File menu to exit the program.
See troubleshooting guide in Bection 10.7].

~ o oo

WinvCC4 X

This program MAY MOT wark with the current parallel port mode setting in BIOS, IF the I2C communication problem

! 3 CAMMOT BE RESCLYED IM AMOTHER WAY (Correct device bype andjor slave address settings, reset or power cycle
the E¥M.}, restart this computer and enter the BIOS sekup program. Change the LPT1 parallel port § base address:
0x378 ) to ECP mode or to BI-DIRECTIONAL mode {also called PSJ2 mode or BYTE mode). IF one of these twao modes
is already selected, change to the opposite mode,

The Following parallel port modes were Found to be functional: ECP:Eidirectional + SPP + BI-DIRECTIOMAL,

Figure 24. Corrective Action Required

10.2.1  Setting the PC Parallel Port Mode

Note: Only run the PC BIOS setup program if the 2°C communication problem cannot be
resolved in another way (correct slave address settings, reset, or power cycle the EVM
and/or check that the device type selected was TVP9900).

1. Restart the PC.

2. During the boot process, enter the BIOS setup program by pressing the required key (usually the initial
text screen tells you which key to press).

3. Find the place where the parallel port settings are made.

4. Set the parallel port LPT1 at address 378h to ECP mode or bidirectional mode (sometimes called PS/2
mode or byte mode). If one of these two modes is already selected, then change to the opposite mode.

5. Exit and save changes.

10.2.2  General I°C Error Report

The error report shown in appears when an 1C error occurs at any time other than after the 1°C
system test. In this example, there was an acknowledge error at slave address 0xB8 (the receiver
module). The error occurred on Read Cycle Phase 1 on the device (slave) address byte.

12C Error Report

Fead, Dewv=0:E8, Addr=0.00, D ata=0=00 - MO ACKN: RD1-DEV

I lgnare [2C Acknowledge Ermors Continue | Exit Program

Figure 25. I°C Error
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11  TVP9900EVM Schematics
This chapter contains the TVP9900EVM schematics.
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IMPORTANT NOTICE

Texas Instruments Incorporated and its subsidiaries (TI) reserve the right to make corrections, modifications, enhancements,
improvements, and other changes to its products and services at any time and to discontinue any product or service without notice.
Customers should obtain the latest relevant information before placing orders and should verify that such information is current and
complete. All products are sold subject to TI's terms and conditions of sale supplied at the time of order acknowledgment.

TI warrants performance of its hardware products to the specifications applicable at the time of sale in accordance with TI's
standard warranty. Testing and other quality control techniques are used to the extent TI deems necessary to support this
warranty. Except where mandated by government requirements, testing of all parameters of each product is not necessarily
performed.

Tl assumes no liability for applications assistance or customer product design. Customers are responsible for their products and
applications using TI components. To minimize the risks associated with customer products and applications, customers should
provide adequate design and operating safeguards.

TI does not warrant or represent that any license, either express or implied, is granted under any Tl patent right, copyright, mask
work right, or other Tl intellectual property right relating to any combination, machine, or process in which TI products or services
are used. Information published by TI regarding third-party products or services does not constitute a license from Tl to use such
products or services or a warranty or endorsement thereof. Use of such information may require a license from a third party under
the patents or other intellectual property of the third party, or a license from TI under the patents or other intellectual property of TI.

Reproduction of Tl information in Tl data books or data sheets is permissible only if reproduction is without alteration and is
accompanied by all associated warranties, conditions, limitations, and notices. Reproduction of this information with alteration is an
unfair and deceptive business practice. Tl is not responsible or liable for such altered documentation. Information of third parties
may be subject to additional restrictions.

Resale of Tl products or services with statements different from or beyond the parameters stated by TI for that product or service
voids all express and any implied warranties for the associated T| product or service and is an unfair and deceptive business
practice. Tl is not responsible or liable for any such statements.

Tl products are not authorized for use in safety-critical applications (such as life support) where a failure of the Tl product would
reasonably be expected to cause severe personal injury or death, unless officers of the parties have executed an agreement
specifically governing such use. Buyers represent that they have all necessary expertise in the safety and regulatory ramifications
of their applications, and acknowledge and agree that they are solely responsible for all legal, regulatory and safety-related
requirements concerning their products and any use of Tl products in such safety-critical applications, notwithstanding any
applications-related information or support that may be provided by TI. Further, Buyers must fully indemnify Tl and its
representatives against any damages arising out of the use of Tl products in such safety-critical applications.

Tl products are neither designed nor intended for use in military/aerospace applications or environments unless the Tl products are
specifically designated by Tl as military-grade or "enhanced plastic." Only products designated by Tl as military-grade meet military
specifications. Buyers acknowledge and agree that any such use of Tl products which Tl has not designated as military-grade is
solely at the Buyer's risk, and that they are solely responsible for compliance with all legal and regulatory requirements in
connection with such use.

Tl products are neither designed nor intended for use in automotive applications or environments unless the specific Tl products
are designated by Tl as compliant with ISO/TS 16949 requirements. Buyers acknowledge and agree that, if they use any
non-designated products in automotive applications, TI will not be responsible for any failure to meet such requirements.

Following are URLs where you can obtain information on other Texas Instruments products and application solutions:

Products Applications
Amplifiers Bmplifier.fi.con Audio [nww ircom/audid
Data Converters Automotive [www ii-com/automofivg
DSP [sp Broadband
Interface Digital Control [yww ii.com/digitalcontro]
Logic [oaiciiconi Military [vww T com/militany
Power Mgmt Rowerirconj Optical Networking [xww i.com/opficalnetworR
Microcontrollers Security
RFID Telephony [yww Ti.com/telephony
Low Power Video & Imaging [vww ti.com/vided
Wireless

Wireless [ww ircomiwirelesd
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